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I. Getting Set Up to Work on the Orthodontic Project 
A. On-line training 

1. To login to Learning Central 
a. Go to:  https://learningcentral.health.unm.edu/plateau/user/login.jsp 
b. Use your UNM Net ID and Password 

2. Training required 
a. HIPPAA training for the current year (needs to be repeated yearly) 

 
B. HSC ID username and badge 

1. HSC username and password 
a. All employees on this project need a HSC username and password 
b. Form to fill out online 

i. https://hscssl.unm.edu/HEAT/accountRequest/index.cfm 
ii. Click: “I agree” on the first screen 
iii. Select: “Faculty/Staff Account” as type of account requesting 
iv. See Figure 1.1: HSC ID Request Form 
v. Fields to fill in: 

- UNM ID (SS#): either your UNM ID or your SS# 
- This is required to verify your identity 

- Your first, middle and last names 
- Osteology Lab phone number as the Office Phone number 
- Leave the section beginning with Job Title blank 
- Contact Information: Enter Dr. Heather Edgar as the contact 
- Comments: “Student employee with the Maxwell Museum Orthodontic 

project. Access is needed to the orthodontics database. Please see Gayle 
for additional information.” 

vi. Click: “Submit Form” 
2. HSC ID badge 

a. If you will be helping to scan images, you will also need a HSC ID badge 
b. HSC contact: Analyst Radiology Information Specialist 

i. See Appendix A: Directory for contact information 
ii. Daniel will provide you with the necessary forms to get approved for a 

HSC ID badge. 
iii. Get badge from Hospital Security  

- Photo ID required 
c. Replacement HSC ID badge 

i. Got to hospital security and request a new badge 
ii. Replacement form needs to be filled out 
iii. Pay $15 fee 
iv. Option: Retake photo, or they can use the photo on file 

 
C. Logging onto the computers in the Osteology Lab 

1. User name and password 
a. Username and Password will be provided 

2. This allows you to log onto any of the computers in the lab 
3. To access to the N:\ drive  
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a. You will need to also log onto VPN client 
b. See Section IV: Logging onto VPN Client 

 
D. Orthodontic database reporter 

1. Every research assistant who will be entering data will need to have their name 
added to the Orthodontic Database as a reporter for ancestry estimation 

2. See Section IV-B: At the Osteology Lab for direction on computer log on 
3. To add a new reporter 

a.  Open the database 
i. Location:    N:\Database 
ii. File:    “Orthodontics.mdb” 
iii. File type:    Microsoft Access 

b. Click “Open” if you get a “Open File – Security Warning” window 
c. If you get a “Securing Warning” bar across the top of the screen 

i. Click: “Options…” 
ii. Window pops up “Microsoft Office Security Options” 
iii. Select: “Enable this content” 
iv. Click: “OK” 

d. From “Form View” 
i. Click “Reporters” button within Ancestry Estimates window 
ii. Window pops up “Reporters” 
iii. Add a new record 
iv. Enter your name (first and last) 
v. Report your self-identified race 
vi. Exit out of the window 
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Figure 1.1: HSC ID Request Form 
 

 
 
______________________________________________________________________________ 
Screen view of requesting an HSC User ID. See Section IB1: HSC Username and Password 
for specifics on how to fill out this form.  
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II. Labeling of Physical Records 
A. Order of records for labeling 

Note: The transfer patients were the first patients to be accessioned. After the transfer 
patients, the new patients who joined Dr. Economides’ practice in 1999 were 
accessioned. These new patients were accessioned in reverse order, such that the 
higher patient number assigned by Dr. Economides correlates to a lower accession 
number. Patient’s who joined Dr. Economides’ practice in December of 1998 were 
accessioned after the patients who joined in January. After all 1998 patients were 
accessioned, then the 1997 patients were accessioned, etc. 

 
B. Accession number (unique identifier) 

1. Example:   “2005.19.70” 
2. Accession number:   “2005.19.” 
3. Object number: last number of the unique identifier 

a. Every Patient must have their own, unique object number.  
b. In one or two cases, multiple patients were in one folder.  

i. In these cases, “A” and “B” were added to the object number.  
ii. Example: 2005.19.70A and 2005.19.70B 

 
C. Label the patient folder with the patient’s accession number 

1. Label with “Sharpie® Permanent Marker Ultra Fine Point” 
2. Label in the upper right hand corner, under then patient number 

 
D. EVERY paper, photo, and x-ray needs to be labeled with the patient’s accession 

number 
1. Papers:  

a. Label with “Sharpie® Permanent Marker Ultra Fine Point” 
b. Label upper, right hand corner 
c. Not too close to the top of the page – number gets cut off when photocopying 

2. Photos:  
a. Label with “Sharpie® Permanent Marker Ultra Fine Point” 
b. Label on the backside of the photo, not on the image 

3. X-Rays:  
a. Label with “Z↑G® Photo Signature, black, 5 point” 
b. Label in one of the lower corners, near the patient’s name if possible 

4. Transparency: 
a. Transparencies are traces of lateral x-rays which were used to take 

cephalometric measurements. 
b. See Figure 2.1: Sample X-Ray with Cephalometric Transparency Trace 
c. Remove tape from transparency and  x-ray  
d. Label transparency with “Sharpie® Permanent Marker Ultra Fine Point” 
e. Place both transparency and x-ray in “Perma Dur Envelope” 
f. Label envelope with “Sharpie® Permanent Marker Ultra Fine Point” 

 

-5- 
 



Figure 2.1: Sample X-Ray with Cephalometric Transparency Trace 
 
 

 
 

Transparency 

X-Ray with transparency 
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III. Labeling and Deidentifying Dental Casts 
A. Match patient’s number 

1. On patient’s cast to the patient’s folder 
2. Have the box of patient folders with you for easier matching 

 
B. Label the box holding the casts with the corresponding accession number 

1. Use a “Sharpie® Permanent Marker Ultra Fine Point” to label the box 
a. Label at the bottom of the box, below the drawer pull 

2. Remove any patient identifier from Dr. Economides or other dentist 
a. Specifically remove the paper in the front of the box 

 
C. Label the cast 

1. Use a “Sharpie® Industrial Super Permanent Ink Fine Point” to label the cast 
a. Write the label on the bottom of the cast at the widest point 

2. Remove any Patient Identifiers, such as 
a. Name 
b. Patient number 

i. Remove from cast 
ii. And from the box if present 

c. Date of birth 
3. Do NOT remove 

a. Date cast was taken 
b. Age of the individual when the cast was taken 

 
D. Notes for successfully removing patient identifiers 

1. Some labels are easy to remove 
2. Labels with dates can be carefully cut to remove patient identifiers while leaving 

dates 
3. Erasers can sometimes remove patient identifiers written in pencil without having 

to use an “X-ACTO®” 
4. A “Sharpie® Industrial Super Permanent Ink Fine Point” can be used to color 

over patient identifiers  
5. Use an “X-ACTO®” knife to scratch the surface of the cast if needed to remove 

patient identifiers 
a. Uses of an “X-ACTO®” knife to scratch the surface of the cast should be a 

last attempt 
b. This does damage the cast and should be avoided as much as possible.  

 
E. NOTE: If cast is present but do not have the corresponding patient folder 

1. Make a note of this patient 
2. Do NOT de-identify these casts 
3. These casts will be dealt with at a later time 
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IV. Logging onto VPN Client  
A. Purpose:   This will allow you to access the database and all images pertaining to the 

Orthodontic Project, as well as other relevant files. 
 

B. At the Osteology Lab: 
1. See Section I-C: Logging onto the computers in the Osteology Lab 
2. To log onto VPN Client in the Osteology Lab: 

a. Go to:  Start \ All Programs \ Cisco Systems VPN Client \ VPN Client 
b. Select:  “HSC-Network_VPN” 
c. Click:  “Connect”    (upper left corner) 
d. Enter:  Your HSC username and password 
e. Press:  “Enter” 

3. To access the (N:) Drive 
a. If you can see the (N:) Drive 

i. From “My Computer” 
ii. Click on: “Orthodontic Imaging on ‘hsc-truchas\departments’ (N:)” 
iii. Enter: Your HSC username and password 
i. For HSC Login: “health\username” 
iv. Press: Enter 

b. If you cannot see the (N:) Drive 
i. From “My Computer” 
ii. Tools → “Map Network Drive…” 

- Drive: “N:    \\hsc-truchas\departments” 
- Folder: “\\hsc-truchas\departments\Orthodontic Imaging” 

iii. Click: “Finish” 
 

C. At the hospital: 
1. Hospital login passwords are required to be changed every 180 days 
2. If computer says “saving settings,” turn it off, and then back on 
3. To login: 

a. Novell Client Login 
i. Enter: Your HSC username and password 

b. Windows Workstation Login 
i. Enter: PACS username and password 

- Username and password will be provided 
ii. This is NOT the same as your HSC username and password 
iii. The PACS password will be shared with you when you join the 

Orthodontic Project. Everyone uses the same PACS username and 
password to log onto the computers in the Radiology Department. 

 
D. DO NOT FORGET TO LOG OUT WHEN YOU ARE DONE!  

This is important in order to protect patient privacy.  
 





V. Scanning Images  
A. General notes: 

1. There are two sources of images for patients. The physical photos and x-rays 
located within the patient’s folder, and electronic photos received from Dr. 
Economides.  
a. Physical photos and x-rays addressed in Section V. Scanning Images and 

Section VI. Photo and X-Ray Editing 
b. Electronic photos are addressed in Section VII. Editing Electronically 

Received Photos 
2. Scan photos and x-rays at the hospital 
3. Scanned images are to be saved to patient specific e-folders 
4. For each patient, create an e-folder for the images 

a. Location: “N:\Images\Orthodontics\Need to be Deidentified and edited” 
b. Every patient needs to have its own e-folder within the above e-folder 

i. Name the e-folder according to the patient’s accession number 
ii. Example: “2005_19_xxxx” 

5. Once images have been scanned, they will be edited to remove confidential 
information 
a. See Section VI. Photo and X-Ray Editing 

 
B. Scanning photos 

1. Notes:  
a. Only the inter-oral photos get scanned.  
b. None of the full face photos get scanned.  
c. For examples of inter-oral photos, see Figure 5.1 Sample Inter-Oral Photos 

2. Open Photoshop 
a. Icon on desktop 
b. Or from “Start Menu” 

3. File → Import → “Epson twain Pro” 
4. Click:  “Preview” 
5. Select: Area of preview to scan 
6. Click:  “Scan” 
7. Close window: “Close” 
8. See Figure 5.2 Screen Shot for Scanning Photos 
9. Save image 

a. Location: “N:\Images\Orthodontics\Need to be Deidentified and edited” 
b. Every patient needs to have its own e-folder within the above e-folder 
c. For image naming, see Appendix B: Image Naming Convention 

i. For more efficient scanning 
- Save all images of a single treatment date as one file 
- Use “ALL” for the ViewCode 

ii. During photo editing this single e-file will get saved into numerous e-files, 
one for each image 

d. Click:  “Save” 
10. When done for the day, do a “preview” scan of a blank screen. Otherwise the 

computer will retain the previously scanned inter-oral photos. 
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C. Scanning x-rays 
1. Notes:  

a. All x-rays, except for bite-wings, need to be scanned.  
b. X-Ray scanning is done at the hospital on the Vidar Twain Scanner there 
c. Most commonly encountered: 

i. Lateral x-rays 
ii. Panaview x-rays 

d. Less common views occasionally encountered: 
i. Anterior-posterior x-rays 
ii. Hand x-rays 
iii. TMJ centered lateral x-rays 
iv. Waters View x-rays 

e. Additional x-rays may be included in the patient’s folder and do require 
scanning 

f. For examples of x-rays, see Figure 5.3: Sample X-Rays  
2. Open Photoshop 

a. Icon on desktop 
b. Or from “Start Menu” 

3. File → Import → “Vidar Twain 32 Version 5.2.1.” 
a. See Figure 5.4A: Window for Scanning using the Vidar Twain 

4. Settings for scanning: 
a. Image Properties: 

i. Resolution: 300 
ii. Depth: 12 
iii. Num. Films: 1 (or number of films being scanned) 

b. Scan Size: “Auto Size” 
c. Select: “Multi-Film Mode” 

5. Click:  “Scan” 
a. See Figure 5.4B: Window for naming the scanned file 

6. Click:  “Browse” 
a. See Figure 5.4C: Window for selecting the file’s location 

7. Select the location of the file export 
a. Every patient needs to have its own e-folder within the above e-folder 
b. Select or create a folder for the patient. But do not enter file name here. 
c. Location:  “N:\Images\Orthodontics\Need to be Deidentified and edited” 

i. Choose specific e-folder with the patient’s accession number 
8. Click: “Save”  

a. This will return you to the window in Figure 5.4B 
9. Enter file name in “Save Images as:” 

a. See Appendix B: Image Naming Convention 
10. Load x-ray into the scanner 

a. Orientation of images 
i. See Figure 5.5: Sample X-Ray Scanning Orientation  
ii. Notes:  

- Description of x-ray orientation is based on your view, not what is 
facing the machine.  
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- Orientation differs depending on how the image is saved (TIF or 
Bitmap).  

- Must be scanned at a depth of “12,” which requires file type TIF . 
iii. Panaview x-rays:  

- Superior side is on the left 
- “R” on the image needs to be superior  

iv. Lateral x-rays 
-  Anterior portion of the skull is on the left 
- Inferior portion of skull faces superior 

11. Click:  “OK” – machine will feed the film though 
12. After scan is complete, open the image to verify that it scanned correctly 
13. If unable to scan x-ray using the Vidar, scan using the Epsion scanner 

a. Quality will not be as good, but is better to have poorer quality than to lack 
the image for the database. 

 
D. After scanning delete these files: 

1. i9999.dat    (or may be named “i9999”) 
2. imgs.lst 
3. These files are not important, and they take up room on the server. 
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Figure 5.1: Sample Inter-Oral Photos with View Codes 
 
 

 

All five inter-oral photos as scanned 
View Code: “ALL” 
(Will get edited into five separate images during photo editting) 

Maxillary Occlusal 
View Code: “mxo” 

Mandibular Occlusal 
View Code: “mdo” 

Left Lateral Bite 
View Code: “llb” 

Right Lateral Bite 
View Code: “rlb” 

Anterior Bite 
View Code: “antb” 
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Figure 5.2: Screen Shot for Scanning Photos 
 

 

Preview Window

- Use this window to select 
desired images to be scanned. 

- Note: At the end of the day, 
do a “Preview” scan without 
photos. Otherwise anyone 
trying to scan photos will be 
able to see the patient’s 
photos. 
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Figure 5.3: Sample X-Rays with View Codes 
 

 

Waters View x-ray 
View Code: “waters” 

Hand x-ray 
View Code: “hd” 

Anterior-Posterior x-ray 
View Code: “AP” 

Panaview X-Ray 
View Code: “pan” 

Lateral x-ray 
View Code: “lat” 

Right TMJ x-ray 
View Code: “RTMJ” 

Left TMJ x-ray 
View Code: “LTMJ” 
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Figure 5.4: Screen Shots for Scanning X-Rays 
 
Figure 5.4A: Window for scanning using the Vidar Twain 

 

Check these 
before scanning.  

Step 5

Figure 5.4B: Window for naming the scanned file 

 

Step 6

Step 11

Figure 5.4C: Window for selecting the file’s location 

 

Step 7 

Step 8

Step 9 
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Figure 5.5: Sample X-Ray Scanning Orientation 
 
 

 Panaview x-rays:  
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- Superior side is on the left 
- “R” on the image needs to be superior  

 
 
  

 

These images are how you should see the x-ray 
as you are looking at it sitting in the x-ray 
scanner. This side faces out from the machine. 
 
These are correct when image is saved as a TIF 
file. Check type of file before correcting 
orientation. 
 
Other x-ray images are not as common. 
Therefore, they are not the focus of orientation 
descriptions.  

 
 
 
 
 
 
 
Lateral x-ray 

- Anterior portion of the skull is on the right 
- Inferior portion of skull faces superior 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



VI. Photo and X-Ray Editing 
A. See Section V: Scanning Images   

1. Images scanned 
2. Saved in e-folder “Need to be Deidentified and edited “  

a. Location: “N:\Images\Orthodontics\Need to be Deidentified and edited” 
b. All images for one patient are in one e-folder 

 
B. For editing of photos and x-rays 

1. For images of tools, see Figure 6.1: Adobe Photoshop CS3 Tools  
2. Check EVERY image: photos and X-Rays 
3. Check that these files have been deleted 

a. i9999.dat    (or may be named “i9999”) 
b. imgs.lst 

4. For photo e-files containing multiple images (ViewCode: ALL) 
a.  Need to be saved as individual e-files (save as) 
b. See Appendix B: Image Naming Convention  

5. Use “Eyedropper Tool (I)” to match color near patient identifier 
a. Any area on image that includes: (includes, but not limited to) 

i. Patient name 
ii. Patient age 
iii. Patient number 
iv. Data image taken 
v. Orthodontist 

6. Select area to fill in 
a. For photos, use “Quick Selection Tool (W)” for best results 
b. For x-rays, use “Rectangular Marquee Tool (M)” for neat square 

7. Fill in area selected  
8. Crop, flip, and rotate image as required 

a. See Figure 6.2: Sample Images with final orientation  
b. Crop to include only the image desired  

i. Crop x-rays and photos if there is excess area included in the image 
ii. Crop photos when there is a duplicate image so that only one image 

remains 
iii. Use the “Crop Tool (C)” for easy cropping 

c. Flip (mirror image) if x-ray is not oriented correctly 
i. Lateral x-rays – facing to the right of the screen 
ii. Panaview x-rays –  patient’s left on the right side of the screen 
iii. AP x-rays – patient’s left on the right of the screen 
iv. Water’s x-rays – patient’s left on the right of the screen, chin pointing up 

d. Rotate images as needed  
i. Photos: should be oriented as if looking at the person 
ii. X-Rays: panaview x-rays should be oriented horizontally  

9. Addition of x-ray rulers 
a. Template rulers need to be added 

i. Varies by image view 
ii. In e-folder “N:\Images\Orthodontics\Need to be Deidentified and edited” 
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- “LatRuler.tif” 
- “PanRuler.tif” 

b. To add template ruler to x-ray: 
i. Open template 
ii. Select entire image using “Rectangular Marquee Tool (M)” 
iii. Copy 
iv. Open x-ray that requires template ruler 
v. Paste ruler on x-ray (will paste on a new layer) 
vi.  Use “Move Tool (V)” to position ruler template into the correct position 

10. Once all images in e-folder have been edited  
a. CUT and paste e-folder with edited images to appropriate location 

i. Location: “N:\Images\Orthodontics\Scanned photos” 
b. Images organized by accession number 

→ N:\Images\Orthodontics 
→ E-Folder with groups of 500 Patients  
   Example: “2005_19_1-2005_19_500” 
→ E-Folder with groups of 50 Patients 

   Example: “2005_19_51-2005_19_100” 
→ E-Folder for each Patient  

   Example: “2005_19_70” 
 

C. Final image modification 
1. See Section VIII: Batch Image Processing for Image Conversion to JPEG 
2. After batching, 

a. Sort images into folders  
b. Location: “N:\Images\Orthodontics\all images-ready for web” 

3. These folders will also contain images received electronically 
a. See Section VII: Editing Electronically Received Photos 
b. When multiple copies of same image on the same date exist, change the last 

number “Ordinal.” 
i. See Appendix B: Image Naming Convention 
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Figure 6.1: Adobe Photoshop CS3 Tools 
 

Rectangular Marquee Tool (M) 

Quick Selection Tool (W) 

Crop Tool (C) 

Eyedropper Tool (I) 

Move Tool (V) 
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Figure 6.2: Sample Images with final orientation 
 

 

Mandibular Occlusal 
View Code: “rlb” 

Panaview x-ray 
View Code: “pan” 

Lateral x-ray 
View Code: “lat” 

Maxillary Occlusal 
View Code: “mxo” 

Anterior Bite 
View Code: “antb” 

Right Lateral Bite 
View Code: “rlb” 

Left Lateral Bite 
View Code: “llb” 
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Figure 6.2: continued  
 

Right TMJ x-ray 
View Code: “RTMJ” 

Hand x-ray 
View Code: “hd” 

Waters View x-ray 
View Code: “waters” 

Left TMJ x-ray 
View Code: “LTMJ” 

Anterior-Posterior x-ray 
View Code: “AP” 
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VII. Editing Electronically Received Photos 
A. General notes: 

1. These photos were retrieved from Dr. Economides’ computer.  
2. Some are duplicates of those photos in the patient’s folder. However, these photos 

include images taken during treatment that are not included in the folder.  
3. All inter-oral photos (and x-rays when present) will be included. Full face photos, 

random photos, and “.cmt” files will not be included in the final results. 
4. Location: “N:\Images\Economides\Image” 

a. Are organized by the year the patient joined. 
b. Year joined indicated by the patient number  

5. Editing process is comprised of 8 stages of steps 
 

B. Example used to describe stages 
1. As this is a complex series of steps, a fictitious patient has been created to use as 

an example.  
2. Patient 2005.19.00 is not a valid accession number. None of the images used in 

this section as an example are associated with their real accession number.  
 

C. Stage 1: Change folder name from patient number to accession number 
1. Location: “N:\Images\Economides\Image” 
2. Patients are organized by the year (first few numbers of the patient number) 
3. Check the face photos in the folder to the face photos in the e-folder 

a. Occasionally multiple patients have been found in one e-folder 
4. Change the e-folder name from the patient number to the accession number 

a. Format e-folder name with “_” instead of “.” 
b. Example: “2005_19_00” instead of “2005.19.00” 
 

D. Stage 2: Adding accession number to file name 
1. Open Photoshop 
2. File → Browse 

a. See Figure 7.1: Browsing Images 
3. In browse window, locate the first e-folder to begin editing 

a. Example: 2005_19_00 
b. Select all images and right click over the images 
c. Click on “Batch Rename…” 
d. See Figure 7.2: Preparing to Batch Rename 

4. See Figure 7.3: ‘Batch Rename’ Window – Stage 2 
a. “Destination Folder” – by selecting “Copy to other folder,” the e-files selected 

will be copied, the e-file names will be changed, and pasted into the selected 
e-folder. 
a. “Browse…” – select e-folder “N:\Images\Economides\to edit\to crop” 

b.  “New Filenames” – as it is set up in Figure 7.3 the patient’s accession 
number will be correctly added to the e-file name 
i. To change, select from the pull down menus (menu to the left affects 

options in menus to the right)  
ii. Add or delete lines of options by the “-“ or “+” buttons 
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c. “Preview” – shows an example of how the new e-file names will appear 
d. Click “Rename” 

5. Repeat Steps 4 and 5 for the next patient, continuing for as many patients as will 
be renamed at the time. 

 
E. Stage 3: Sort files 

1. All e-files renamed in Stage 2 will be copied to “N:\Images\Economides\to edit\to 
crop” 
a. See Figure 7.4: ‘N:\Image\...\to crop’ – Unsorted 
b. Figure 7.4 includes examples of the types of e-files 

2. Move all “CMT Files” into e-folder “N:\Images\Economides\ext cmt” 
3. Move image files from “N:\...\to crop” into subfolders: 

1. E-folder: “N:\…\to copy\face” – any image that contains only the face of the 
patient without including inter-oral images. Also include random photos of 
any non-tooth focused image. 
i. After verifying that no images of teeth were accidentally moved here, 

delete all images. 
2. E-folder: “N:\...\to copy\i1” – any image that contains only one inter-oral view 
3. E-folder: “N:\...\to copy\i3” – any image that contains three inter-oral images. 

These usually are “antb,” “llb,” and “rlb” but may include “mdo,” “mxo” or 
any other image. 

4. E-folder: “N:\...\to copy\i9” – any image that has 8 or 9 images organized in a 
3x3 grid. The top row usually includes three face photos, with the remaining 5 
or 6 images being inter-oral photos. The middle square of the grid may either 
be an inter-oral image or else black. Inter-oral images include “antb,” “llb,” 
“mdo,” “mxo,” “rlb,” and may include another, non standard, image.  

5. E-folder: “N:\...\to copy\other” – other images such as x-rays or other images 
of teeth that do not fit into one of the previous three folders. 

6. See Figure 7.5: ‘N:\Image\...\to crop’ - Sorted 
 

F. Stage 4: Change date format in file name 
1. E-file names include the date they were taken. The received format is 

“MMDDYY,” but as discussed in Appendix B: Image Naming Convention, 
dates need to be in the format “YYYYMMDD.” 

2. Open “Bulk Rename Utility” 
a. See Figure 7.6: Bulk Rename Utility 
b. Notes:  

i. This program works by identifying text within e-file names and modifying 
the text as instructed.  

ii. The three renaming options indicated (letters C, D, and E) are the options 
most likely to be used. 

3. Select sub e-folder of images to rename 
4. See Figure 7.7: Examples of Bulk Renaming 
5. Additional text to remove: 

a. All “.i#” suffixes  
i. “.i1”  
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ii. “.i3” 
iii. “.i9” 

b. Any stage of treatment information 
i. “-pret”  
ii. “-postt” 
iii. “-pres” 

6. Do not remove “a” suffixes at this point. This will be deal with later in Stage 7. 
a. Example: “103096.i3a” or “19961030a” 

 
G. Stage 5: Add view code and ordinal number to file name 

1. Notes: 
a. Uses the same program described in Stage 2 
b. For each of the three types of files (i1, i3, and i9) similar, but different steps 

are required. 
2. For “i1” Images 

a. Location: “N:\Images\Economides\to edit\to crop\i1” 
b. Sort single images into subfolders according to view of teeth 
c. See Figure 7.8: Sorting “.i1” Images 
d. Open Photoshop’s Browsing window 

i. Refer to Figure 7.1 and Figure 7.2 
e. In browse window, locate the “i1” e-folder 
f. Select all images and right click 
g. Click on “Batch Rename…” 
h. See Figure 7.9: ‘Batch Renaming’ Window – Stage 5: i1 

i. “Destination Folder” – by selecting “Rename in same folder,” the e-file 
names will be changed, without a copy of the e-file being made. 

ii. “New Filenames” – as it is set up in Figure 7.9 will add the view code and 
ordinal number to the end of the e-file name. Enter the appropriate view 
code based on the images selected.  

iii. “Preview” – shows an example of how the new e-file names will appear 
i. Repeat for all sub e-folders 
j. All images should have view code and ordinal number added. No copies of 

images are necessary.  
3. For “i3” Images 

a. Location: “N:\Images\Economides\to edit\to crop\i3” 
b. Open Photoshop’s Browsing window 

i. Refer to Figure 7.1 and Figure 7.2 
c. In browse window, locate the “i3” e-folder 
d. Select all images and right click 
e. Click on “Batch Rename…” 
f. Repeat batch rename for all three view codes  

i. View codes: “antb,” “llb,” and “rlb” 
ii. These will be edited in Stage 6 

g. See Figure 7.10: ‘Batch Renaming’ Window – Stage 5: i3 
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i.  “Destination Folder” – by selecting “Copy to other folder,” the e-file 
selected will be copied; the e-file names will be changed, and pasted into 
the selected e-folder.  
- Location: “N:\Images\Economides\to edit\to crop\i3” 

e-folder destination  add view code 
N:\...\i3\0-antb-crop  antb 
N:\...\i3\0-llb-crop   llb 
N:\...\i3\0-rlb-crop   rlb 

ii. “New Filenames” – as it is set up in Figure 7.10 will add the view code 
and ordinal number to the end of the e-file name.  
- It is crucial that the destination e-folder and the view code match! 

iii. “Preview” – shows an example of how the new e-file names will appear 
iv. Check that the view code noted on destination e-folder matches the view 

code being added to the e-file name. 
4. For “i9” Images 

a. Location: “N:\Images\Economides\to edit\to crop\i9” 
b. Open Photoshop’s Browsing window 

i. Refer to Figure 7.1 and Figure 7.2 
c. In browse window, locate the “i9” e-folder 
d. Select all images and right click 
e. Click on “Batch Rename…” 
f. Repeat batch rename for all five view codes 

i. View codes: “antb,” “llb,” “mdo,” “mxo,” and “rlb” 
ii. These will be edited in Stage 6 

g. See Figure 7.11: ‘Batch Renaming’ Window – Stage 5: i9 
i.  “Destination Folder” – by selecting “Copy to other folder,” the e-file 

selected will be copied; the e-file names will be changed, and pasted into 
the selected e-folder. 
- Location: “N:\Images\Economides\to edit\to crop\i9” 

e-folder destination  add view code 
N:\...\i9\0-antb-crop  antb 
N:\...\i9\0-llb-crop   llb 
N:\...\i9\0-mdo-crop  mdo 
N:\...\i9\0-mxo-crop  mxo 
N:\...\i9\0-rlb-crop   rlb 

ii. “New Filenames” – as it is set up in Figure 7.11 will add the view code 
and ordinal number to the end of the e-file name.  

iii. “Preview” – shows an example of how the new e-file names will appear 
iv. Check that the view code noted on destination e-folder matches the view 

code being added to the e-file name. 
h. E-files with a sixth inter-oral image (see Figure 7.4 for example) 

i. Copy from “N:\Images\Economides\to edit\to crop\i9” 
ii. Paste in “N:\Images\Economedies\ to edit\ to crop\i9\other” 
iii. Add view code as appropriate. If view is unclear, use view code “other.” 

5. For “other” images 
a. Location: “N:\Images\Economides\to edit\to crop\other” 
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b. Edit e-file name as required depending on image.  
i. If image is of an x-ray: 

- Change the “P_” to “X_”  
- Add the appropriate view code (“lat,” “pan,” etc.) 

ii. See Appendix B: Image Naming Convention 
 

H. Stage 6: Batch edit photos for single images 
i. Notes:  

a. The actions for batch editing the images have already been created. See 
Section 8B: To create/ record an action for an example of creating an action 

b. There is one action that is for the “.i1” images that require rotating, 
specifically “mdo” and “mxo.” For the “.i3” images, there are three actions, 
and there are six actions for the “.i9” images.  

c. See Figure 7.12: ‘Orthodontic Actions’ for Photo Editing. This figure 
shows the different actions that have been created for editing the 
electronically received images.  

ii. Open first image (in Photoshop) within the e-folder to be edited 
iii. File → Automate → Batch 

a. See Figure 7.13: Batch Photo Editing 
b. Steps use the “antb” view of the “.i3” images as an example. 
c. The same steps will be required for all “.i3” and “.i9” views.  

iv. “Play” box 
b. “Set: Orthodontic Actions” 
c. “Actions: i3 – crop antb” 
i. “Source” box 

a. Select: “Source: Folder” 
b. “Choose…” – e-folder selected needs to match the action selected 

i. Location: “N:\Images\Economides\to edit\to crop\” 
ii. “Destination” box 

a. Select “Destination: Save and Close” 
iii. Click “OK” 
iv. Visual check of images for correct views, and change e-file name as needed.  

a. Notes: “Orthodontic Actions” for batch editing actions crop to specific 
portions of the original images. However, not all original images have the 
same views in the same locations. Change e-file names if view does not match 
view code.  

b. See Figure 7.14: Example of cropped images requiring name changes 
 

I. Stage 7: Move and sort edited images to final location 
1. Edited images in e-folders:  (“N:\Images\Economides\to edit\”) 

a. N:\...\to crop\i1 
i. All images should be final 

b. N:\...\to crop\i1\antb 
c. N:\...\to crop\i1\mdo-rotate 
d. N:\...\to crop\i1\mxo-rotate 
e. N:\...\to crop\i1\other 
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f. N:\...\to crop\i3\0-antb-crop 
g. N:\...\to crop\i3\0-llb-crop 
h. N:\...\to crop\i3\0-rlb-crop 
i. N:\...\to crop\i9\0-antb-crop 
j. N:\...\to crop\i9\0-llb-crop 
k. N:\...\to crop\i9\0-mdo-crop 
l. N:\...\to crop\i9\0-mxo-crop 
m. N:\...\to crop\i9\0-rlb-crop 
n. N:\...\to crop\i9\other 

2. Scan through all images in all e-folders (a-n) to ensure that images are correctly 
edited and have the correct view code. 

3. Remove any “a” associated with dates 
a. See Stage 4, step 6 
b. Use “Bulk Rename Utility” to search for e-files containing “a_” 

i. Searching this way will no pick up on the “a” in the view code “antb” 
ii. Delete “a” 
iii. If attempting to delete the “a” returns the error message that there is 

already an e-file with this name, change the ordinal number, and then 
remove the “a”. 

4. Cut and paste all images from e-folders (a-n) 
a. Paste to: “N:\Images\Orthodontics\all images-ready for web” 

5. Sort all e-files into the patient’s individual e-folders 
 

J. Stage 8: Delete copies created during editing 
1. Copies located in e-folders 

a. N:\Images\Economides\to edit\to crop\i3 
b. N:\Images\Economides\to edit\to crop\i9 

2. These e-files were copied and view codes added to the copies.  
a. It is best to wait to delete these e-files until all images have been batch edited 

in case mistakes are made.  
3. All “.i1” images were edited without additional copies being made. Therefore, 

there are no copies of “.i1” images which require deleting.  
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Figure 7.1: Browsing Images 
 

 

This option will cause 
this window to open. 
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Figure 7.2: Preparing to Batch Rename 
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Figure 7.3: ‘Batch Rename’ Window – Stage 2 
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Figure 7.4: ‘N:\ Images\...\to crop’ – Unsorted 
 

 
 

Types of E-Files: 
 

            
CMT files     Face images*    “.i1” images (2 examples) 
 
 

         
“.i3” images (2 examples+)    “.i9” images (2 examples†) 

 
 

* These files also have an 
“.i1” extension. 

+  Note: See Figure 7.14 for 
consequences of different 
inter-oral views. The first 
arrangement is more 
common than the second. 

† Note: The first example 
has 8 (5 inter-oral) images 
while the second example 
has 9 (6 inter-oral) 
images.
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Figure 7.5: ‘N:\ Images\...\to crop’ – Sorted 
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Figure 7.6: Bulk Rename Utility 
 

 

A B

 C D E

F

 
 
 

Name  File names in this column are as they currently are.  A 
  
New Name File names in this column are as they will appear once the specified changes have been 

made.  
B 

 
  
Repl. (3) Text entered into the “Replace” field will be identified and replaced with any 

text entered into the “With” field. 
C 

 
  
Remove (5) Will remove/delete all text located after character # (noted in “From” field) to 

character # (noted in “to” field) 
D 

 
  
Add (7) Adds any text extered into the “Insert” field such that the first character in the 

“Insert” field is the # character (noted in the “at pos.” field) 
E 

 
  
“Rename” Clicking this button will change the files names as described. This action cannot 

be undone. Therefore, check the file names in the “New Name” column (B) 
carefully before clicking.  

F 
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Figure 7.7: Examples of Bulk Renaming 
 
Example 1 

 
 
Example 2 

 

 
 
 
 
Notes:  
All images are selected, and 
yet only e-files that include 
“96.i3” will have their name 
changed.  This is because 
there is text entered to 
“Replace” under “Repl. (3),” 
but not for “With.” This 
removes the text only for 
those e-file names that 
contain the text. 
 
Although text is inserted to 
“Add (7)” the box is not 
checked and so will not be 
added. 
 
 
 
 
 
 
 
 
 
 
Note:  
Only the 6 files with dates 
from 1996 are selected. 
Because of this, with boxes 
for both “Repl. (3)” and “Add 
(7)” checked, the text “96.i3” 
will be replaced and “1996” 
will be added. 
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Figure 7.8: Sorting “.i1” Images 
 

 unsorted “.i1” images 
 

 sorted “.i1” images 
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Figure 7.9: ‘Batch Rename’ Window – Stage 5: i1 
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Figure 7.10: ‘Batch Rename’ Window – Stage 5: i3 
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Figure 7.11: ‘Batch Rename’ Window – Stage 5: i9 
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Figure 7.12: ‘Orthodontic Actions’ for Photo Editing 
 

 

Use in Section 8: Batch Image Processing 

Rotates 180°. Use for “mdo” and “mxo.” 

Crops “.i3” into the center, right, and left 
images 

Crops “.i9” into individual images. Bottom 
center, bottom right, bottom left, middle 
right, middle left, and middle center.  

 
 
 
Edit using action “rotate 180” Edit using action “i3 – crop llb” 
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Edit using action “i3 – crop antb” 

 
 

    
 
 

 
Edit using action “i3 – crop rlb” 

 
 

 
 



Figure 7.12: continued 
 
Edit using action “i9 – crop antb” 

 
 

    
 
Edit using action “i9 – crop, rotate mdo” 

  
 

 
 
Edit using action “i9 – crop rlb” 

  
 

 
 
 
 

Edit using action “i9 – crop llb” 

 
 

       
 
Edit using action “i9 – crop, rotate mxo” 

 
 

 
 
Edit using action “i9 – crop other” 
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Figure 7.13: Batch Photo Editing 
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Figure 7.14: Examples of cropped images requiring name changes 
 

 

 

 
 
 

(A) 

(B) 
 
 
 
 
 
 
 
 
 

After editing using action “i9 – crop, rotate mxo,” 
these four images were cropped and rotated to 
these four images.  
 
However, because the inter-oral view (A) is 
different than view (B), even though their 
location in the 9x9 grid is the same, the resulting 
edited images, (A’) and (B’), are different.  

 

 
The e-file name for image 
(A’) needs to be changed 
from “_mxo_1” to 
“_mdo_1” to correctly 
describe the view depicted.   

(A’) (B’) 

Note:  Inter-oral views in non-
standard locations occur for 
both “.i3” and “.i9” e-files. 
These e-files should be 
corrected during Stage 7, 
step 2.  
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VIII. Batch Image Processing for Image Conversion to JPEG 
A. Notes: 

1. Batch editing works by applying the same action to numerous images. When 
setting all images to a uniform size, Photoshop shrinks (or expands) the image to 
fit within the square provided without changing the width to height ratio of the 
original image. 

2. Batch image processing should be done in increments of 500 patients. (Each e-
folder within N:\Images\Orthodontics\Scanned photos.) This way all of the sub e-
folders get done at once. 

3. For images to work on the website they need to be no larger than 800 pixels 
square and need to be saved as a JPEG 

4. End goal for file location: 
a. Original image e-files remain in the patient’s e-folder 

i. Location:   N:\Images\Orthodontics\Scanned photos 
ii. File types: 

- .TIF format 
- Photoshop (.PSD or .PDD) 

b. JPEG image for web  
i. Location:   N:\Images\Orthodontics\all images-ready for web 
ii. File type: JPEG 

5. After you have batch edited a folder of images, contact the HS Library and 
Informatics Center Manager, so that he can refresh the website with the added 
images.  
a. See Appendix A: Directory for contact information 

6. The steps described in Section B are only for creating/recording an action. If 
actions are already created (and they probably are) then skip to Section C: To 
perform batch editing. Section C describes how to run an action that has already 
been created.  

 
B. To create/ record an action for batch editing for web   

1. Open first image (in Photoshop) within series to be batch edited 
2. Window → Actions 

a. See Figure 8.1: Actions Window 
b. Letters describing buttons will be used to identify buttons in directions 

3. See Figure 8.2: Screen Shots for Creating/ Recording an Action  
4. Click button “D – Create new set” 
5. Name “New Set” as “Orthodontic Actions” → Click “OK” 

d. See Figure 8.2A 
6. Click button “E – Create new action” 
7. Name “New Action” as “Batch Edit for Web” → Click “Record” 

d. See Figure 8.2B 
8. File → Automate → Fit Image 

a. Set both “Width” and “Height” to 800 pixels 
b. By setting “Fit Image” to a square, will prevent image ratio from being 

changed 
c. See Figure 8.2C and Figure 8.2D 
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9. File → Save for Web and Devices  
a. Options: “JPEG,” “High,” “Quality: 60” 
b. Select “Save” 
c. See Figure 8.2E and Figure 8.2F 

10. Specify folder where it should save the image 
a. Folder:   “N:\Images\JPEG's” 
b. Select “Save” 
c. See Figure 8.2G 

11. Click button “A – Stop playing/ recording” to stop recording 
a. Note: Steps 8 – 10 record what has been done as the action from Step 7 

12. Exit out of the Actions window 
 

C. To perform batch editing using “Batch Edit for Web” Action 
1. Open Photoshop 
2. File → Automate → Batch 
3. See Figure 8.3: Batch Photo Editing 
4. “Play” box 
d. “Set: Orthodontic Actions” 
e. “Action: Batch Edit for Web” 
f. This will perform the steps defining the “Batch Edit for Web” to all e-files within 

the e-folder selected below. 
5. “Source” box 

a. Select: “Source: Folder”   
b. “Choose…” – to specify the e-folder to be batch edited 

i. Location: “N:\Images\Orthodontics\Scanned photos” 
ii. E-folder of 500 within the above e-folder 

c. For “Batch edit for Web,” include subfolders, check “Include All Subfolders” 
6. “Destination” box 

a. Select: “Destination: Folder” 
b. “Choose…” – to specify the e-folder to place copies image 
c. Location: “N:\Images\JPEG's\TIF's” 
d. Notes:  

i. At the completion of “Batch Edit for Web” there will be three (3) sets of 
all images contained in the source folder.  
- (1) original set, unmodified, and still in their separate e-folders within 

“N:\Images\Orthodontics\Scanned photos” 
- (1) edited set, modified and copied to the e-folder “N:\Images\JPEG’s” 

as was specified in the steps of “Batch Edit for Web” action.  
- (1) edited set, copied to the e-folder “N:\Images\JPEG's\TIF's” 

ii. The images in “N:\Images\JPEG’s\TIFs” need to be deleted when done 
with the batch editing. 

iii. It is unclear if it is necessary it is to create this third set of images, but as 
they are duplicates, it is appropriate to delete them. 

7. Click “OK” 
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Figure 8.1: Actions Window 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A Stop playing/recording 
B Begin recording 
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C Play selection 
D Create new set 
E Create new action 
F Delete 

 
 

Button “A” is blue and button “B” is red 
when an action is being recorded.  

 
 
 

 

A    B   C    D    E    F 

A    B   C    D    E    F 

 



Figure 8.2: Screen Shots for Creating/ Recording an Action 
 
Figure 8.2A: Step 5 

 
 

Figure 8.2B: Step 7 

 
 
Figure 8.2C: Step 8 

 

 
 
 
 
 
 
 
 
Figure 8.2D: Step 8a 

 

 

-50- 
 



Figure 8.2: continued 
 
Figure 8.2E: Step 9 

 

 
 
 
 

Figure 8.2F: Step 9a 

 
Figure 8.2G: Step 10 
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Figure 8.3: Batch Photo Editing 
 

 
 

 

Select e-folder within this e-folder 
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IX. General Notes on Data Entry 
A. Accessing the database 

1. Open the database 
a. Location:    N:\Database 
b. File:    “Orthodontics.mdb” 
c. File type:    Microsoft Access 

2. Click “Open” if you get a “Open File – Security Warning” window 
3. If you get a “Securing Warning” bar across the top of the screen 

a. Click: “Options…” 
b. Window pops up “Microsoft Office Security Options” 
c. Select: “Enable this content” 
d. Click: “OK” 
e. Note:  If you get the “Securing Warning” but do not tell Microsoft Access to 

enable the content, you will be unable to access any of the tables 
 

B. Locating the patient in the database 
1. In “Datasheet View” look up patient by name 

a. Can be easiest to locate a patient if patients are alphabetized by last name in 
the “Datasheet View” 

2. Highlight the row with the patients name, and switch to “Form View” 
 

C. Prior to beginning data entry  
1. Remove all documents/ papers, photos, and x-rays from the patient’s folder 
2. Items will either be returned to the folder, pulled for copying, or pulled as 

confidential. 
a. See Section X: Removal of Confidential Information 

 
D. Count all inter-oral pictures and x-rays in the folder 

1. Number of inter-oral pictures and x-rays in the folder should match the number of 
images in the e-folder “N:\Images\Orthodontics\Scanned photos” 

2. If an inter-oral picture was not scanned – scan the picture 
3. If an x-ray was not scanned, why not? Some x-rays are too thick, this seems to be 

especially true for transfer patients. Regardless of why an x-ray was not scanned, 
note its presence in the Comments field. 
 

E. Additional images from Dr. Economides 
1. See Section VII. Editing Electronically Received Photos 
2. Unedited copies of all images received from Dr. Economides 

a. Location: “N:\Images\Economides\Image” 
b. Back-up copy, not involved in image editing process 

i. Location: “N:\Images\Economides\backup all images” 
3. Edited copies 

a. Location:  “N:\Images\Orthodontics\all images-ready for web” 
b. The sub e-folders within contain edited for web scanned images  

 
F. See Section IX. Data Entry Instructions 
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X. Data Entry Instructions 
A. NOTES:  

1. See Figure 10.1: Blank Data Entry Screen  
a. Names of sections, fields, pull down menus, checkboxes and buttons in the 

database are underlined 
 

B. Patient Information 
1. NOTE: This information is found on the patient identification card 
2. Accession Number – (2005.19.xxxx) 
3. Name – Check the name 

a. For First Name, enter the full name, not just a nickname, if full name is not 
already entered 

b. Enter Middle Name if given, or initial if given 
4. Date of Birth 

a. M/D/YY 
b. Database will auto format the date 

5. Sex 
a. “M” – male 
b. “F” – female 

6. Address / City, State, Zip 
a. The address listed in the database is the most recent address that Dr. 

Economides had for the patient. Therefore, do NOT correct address from the 
address listed on the card. 

b. Correcting “Ne” to “NE” (for Northeast) is appreciated (or Nw, Se, Sw) 
7. Phone Number 

a. (505) 123-4567 
b. The database will automatically format the phone number 
c. Do enter the area code – 505 
d. Leave phone number field blank if: 

i. If address in database is out of state 
ii. If no phone number is listed 

 
C. Patient History 

a. NOTE: This information is found on the patient identification card 
b. Check the appropriate squares for: 

a. Thumb sucking 
b. Mouth breathing 
c. Lisp 
d. Tonsillectomy (tonsils removed) 
e. History of Supernumerary Teeth 

 
D. Ancestry Estimates 

1. NOTE:    TWO people must do this independently! 
i. Each ancestry estimation should be its own record 

2. See Section 1C: Orthodontic Database Reporter to add a new reporter 
3. Ancestry estimation is required if: 

-54- 
 



a. If full face photos of the patient are included. 
b. Full face photos may be in the folder, or in the e-folder of Economides images 
c. Either slide images, digital, or hard copy photographs are acceptable. 

4. For ancestry estimation: 
a. EstimateDate: date when you are making the estimation 

i. Enter today’s month/day for date  
ii. The database will auto format and add year. 

b. Reporter: enter your name (last, first) 
i. Begin typing your last name in the Reporter field. The database will 

highlight the name that matches. 
ii. Alternatively, pull down menu will allow for selection of the reporter 

c. Check squares for: 
i. Patient’s Race: 

- You can select more than one 
- Either more than one per record, or more than one record per reporter 
- See Section 4d below 

ii. Race Estimate based on: 
- Traits used for ancestry estimation(s) 
- Select all that were used 

d. NOTE: If you feel that different traits suggest different ancestry estimation(s), 
you can use multiple records to indicate different ancestry estimations and the 
traits that support that ancestry estimation.  

5. Ancestry and trait options 
1. Patient’s Race: 

i. Amerind – “American Indian or Alaska Native” 
- “A person having origins in any of the original peoples of North and 

South America (including Central America), and who maintains tribal 
affiliation or community attachment.” 

- Selection of this race will cause a pull down menu of the different 
recognized tribes to appear 

- If you feel confident selecting a tribal affiliation, do so in this pull down 
menu 

ii. Asian – “Asian” 
- “A person having origins in any of the original peoples of the Far East, 

Southeast Asia, or the Indian subcontinent including, for example, 
Cambodia, China, India, Japan, Korea, Malaysia, Pakistan, the 
Philippine Islands, Thailand, and Vietnam. 

iii. AfAm – “Black or African American” 
- “A person having origins in any of the black racial groups of Africa. 

Terms such as “Haitian” or “Negro” can be used in addition to “Black or 
African American.” 

iv. Hisp – “Hispanic or Latino” 
- “A person of Cuban, Mexican, Puerto Rican, South or Central 

American, or other Spanish culture or origin, regardless of race. The 
terms, “Spanish origin,” can be used in addition to “Hispanic or Latino.” 

v. Hawaiian – “Native Hawaiian or Other Pacific Islander” 
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- “A person having origins in any of the original peoples of Hawaii, 
Guam, Samoa, or other Pacific Islands.” 

vi. EuAm – “White” 
- A person having origins in any of the original peoples of Europe, the 

Middle East, or North Africa.” 
vii. Descriptions of races from “Provisional Guidance on the Implementation 

of the 1997 Standards for Federal Data on Race and Ethnicity.” 
Available on-line at: 

http://www.whitehouse.gov/omb/inforeg/re_guidance2000update.pdf 
2. Race Estimate based on: 

i. Address Indicator 
- This can be especially useful in tribal affiliation if the home address is 

on a reservation 
ii. Name Indicator 
iii. Skin Color Indicator 
iv. Hair Form Indicator 
v. Facial Features Indicator 

6. Maintain a list of patient’s requiring a second ancestry estimation 
a. Word document with the list of patient’s requiring second ancestry estimation 
b. Location:  “N:\Database” 
c. File name: “Second Ancestry Estimation Needed.doc” 

 
E. Treatment Events 

1. TreatmentDate: 
a. Each day of treatment requires its own record with the appropriate date 
b. A “Treatment” consists of any 

i. Photo or x-ray taken 
ii. Any of the Clinical Events: Procedures 

c. Click: Fuzzy Date if day, month, or year is unknown 
d. Click: No Date if no date is given for the treatment even 
e. Click: Treatment Completed for day treatment is completed if given 
f. If either an x-ray or a picture is listed as not having a date, CHECK to see if 

you can find one 
i. For example:  

- If the date cannot be read, but the age (year and month) can be read and 
can be matched with another image, change the date.  

- If the date can be partly read, the complete date can sometimes be found 
on the outside of the patient’s folder.  

ii. If you change the date, or anything about the file name after it has been 
uploaded to the website: 
- Email the analyst/ programmer specialist (Kimberly Hagen) with the 

name changes or file additions. 
2. Clinical Events: 

a. See Figures 10.2 – 10.7 for examples of forms containing treatment 
information 

b. Treatment information may also be found on the outside of the folder 
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c. Pull down menu Procedure: 
i.  Permanent Extraction Request 
ii.  Permanent Extraction Performed 
iii.  Deciduous Extraction Request 
iv.  Deciduous Extraction Performed 
v.  Banding/Bracketing 
vi.  Surgical Exposure Request 
vii.  Surgical Exposure Performed 
viii. De-banding 
ix.  Orthognathic Surgery 
x.  Retention 
xi.  Orthodontic diagnosis 
xii.  Congenitally Missing Teeth 
xiii. POG 

d. For Extractions: 
i. Click: Details to specify teeth extracted 

- See Appendix E: Tooth Naming Convention 
ii. When present, enter both extraction request and conformation of 

extraction performed as separate treatment events, each on the appropriate 
date. 

iii. NOTES:  
- If tooth identified in the folder as having been extracted, but does not 

specify when the extraction occurred, note as “performed,” enter as the 
date when extraction was noted, and under Comments note as  

 “prior M/D/YY extraction performed” 
- On front of the folder if says “no 8’s” enter as Permanent Extraction 

Request 
e. For Banding/Bracketing: sometimes is referred to as appliances placed 
f. For Surgical Exposure:  

i. Click: Details to specify teeth exposed 
- Specify if exposure is requested or performed 

ii. Also noted in file as “uncover” or “close bond” 
iii. See Appendix E: Tooth Naming Convention 

g. For Orthognathic Surgery → then Click: Details 
i. Under Details record dental arc involved in the surgery 
ii. Note in the Comments Field (Section E. Comments) the type of surgery 
iii. Format: M/D/YY surgery type 
iv. Definition:  

orthognathic surgery – surgery of the facial skeleton, such as the 
mandible or maxilla, to restore proper anatomic or functional 
relationship. 

h. For Orthodontic Diagnosis → then Click: Details 
i. Malocclusion class and division/type if given 
ii. Crowding if noted 
iii. TMJ or other problems, select “Other” under Orthodontic Diagnosis 

- Note in Comments 
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- M/D/YY diagnosis – diagnosis noted in Folder 
iv. For examples of forms with diagnostic information see: 

- Figure 10.2: Sample Case Analysis and Treatment Plan 
- Figure 10.3: Sample Medicaid Utilization Review Forms 
- Figure 10.4: Sample Orthodontic Insurance Form 
- Figure 10.5: Sample Patient Identification Card 
- 
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Figure 10.6: Sample Transfer Form 
- Figure 10.7: Sample Treatment Record 

i. For Congenitally Missing Teeth → Click: Details 
i. For TreatmentDate, use date when missing tooth was noted 
ii. Use same tooth naming convention as for tooth extraction 
iii. See Appendix E: Tooth Naming Convention 

j. For POG: enter date of form where mentioned 
3. Photos: for each photo taken on a given day 

a. View: select view of a given photo 
i. mxo maxillary occlusal 
ii. mdo mandibular occlusal 
iii. antb anterior, teeth in occlusion 
iv. llb left lateral, teeth in occlusion 
v. rlb right lateral, teeth in occlusion 
vi. unknown unknown 

b. Photo Date: date photo was taken 
i. NOTE: Once the date has been entered into the TreatmentDate field, 

clicking in this field will cause the database to automatically fill in the 
date.  

ii. If no date is available, click the No Date box  
c. File Location: leave blank during data entry.  

i. Files will be automatically linked 
ii. Exception: images without a date.  

- Manually copy and paste text of e-file names into this field 
iii. Images located in “N:\Images\Orthodontics\all images-ready for web” 

- In this e-folder, images are organized by accession number 
- Images in these e-folders are a combination of two sources, 

electronically received and scanned.  
- N:\Images\Economides 
- N:\Images\Orthodontics\Scanned photos 

d. Note: Multiple pictures taken on the same day are entered in the same record 
4. X-Rays: select view of a given x-ray 

a. View: 
i. lat lateral 
ii. pan panaview 
iii. part partial panaview 
iv. AP Anterior-Poster 
v. hd hand 
vi. unknown unknown 
vii. mxo maxillary dentition 
viii. mdo mandibular dentition 
ix. rtmj right TMJ 
x. ltmj left TMJ 
xi. tmj TMJ side unknown 
xii. waters Waters view 
xiii. other other 
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b. Xray Date: date x-ray was taken 
i. NOTE: Once the date has been entered into the TreatmentDate field, 

clicking in this field will cause the database to automatically fill in the 
date. 

ii. If no date is available, click the No Date box  
c. File Location: leave blank during data entry.  

i. Files will be automatically linked 
ii. Exception: images without a date.  

- Manually copy and paste text of e-file names into this field 
iii. Images located in “N:\Images\Orthodontics\all images-ready for web” 

- In this e-folder, images are organized by accession number 
- Images in these e-folders are a combination of two sources, 

electronically received and scanned.  
- N:\Images\Economides 
- N:\Images\Orthodontics\Scanned photos 

d. Cephalometrics: 
i. Match date of cephalometrics as close as possible to date of x-ray 
ii. Enter cephalometrics to link to lateral x-ray when possible 
iii. If there is no associated x-ray for the date of cephalometrics: 

- Save the file “no xray” as “X_2005_19_accession_date_lat_1”  
- File location: “N:\Images\Orthodontics” 
- Do a “SAVE AS” to keep it separate from the original 
- Move patient’s e-file (no xray) to patient’s e-folder within 

“N:\Images\Orthodontics\all images-ready for web” 
- In database, select View → Other 

- See Figure 10.8: Sample Cephalometrics Form 
- Example form commonly found in patient’s folder 

- See Figure 10.9: Sample Cephalometrics Measurements Screen 
- Blank data entry screen  

- See Appendix F: Cephalometrics 
 

F. Comments – NOTES: 
1. This field is searchable.  
2. Additional information regarding patient treatment events should be entered here.  
3. When possible, include the date associated with any comment. 
 

G. General Notes: 
1. Replace all photos and x-rays into the folder 
2. Papers will either be replaced in the folder or pulled if they contain confidential 

information 
3. See Section XI: Removal of Confidential Information 
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Figure 10.1: Blank Data Entry Screen 
 
 

2 

3 

4 

 
 

D

B 

E 

F 

1 
C

______________________________________________________________________________ 
Data entry screen as seen in Microsoft Access. Letters and numbers correspond to instructions 
found in Section IX. Data Entry Instructions.  

-61- 
 



Figure 10.2: Sample Case Analysis and Treatment Plan 
 
 

 
 

In this example: 
A.   Classical treatment information 
B. and C.   need to be noted in the 

Comments Field. 

Do not enter the information under 
“4. Treatment Plan Steps” as this 
these treatment events have not yet 
occurred.  

______________________________________________________________________________ 
This form does include treatment information and may include hand written confidential 
information that needs to be removed. See Section XI: Removal of Confidential Information. 
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Figure 10.3: Sample Medicaid Utilization Review Forms 
 

 
 

Confidential 

Insurance information - 
Medicaid 

Treatment Information 

Type of malocclusion, and 
often other diagnoses 

Treatment Information 

Missing teeth 

______________________________________________________________________________ 
This form does include treatment information. However, it also does include insurance 
information (Medicaid). See Section XI: Removal of Confidential Information. 
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Figure 10.4: Sample Orthodontic Insurance Form 
 

 
______________________________________________________________________________ 

Insurance 
information 

Treatment 
Information 

Banding/ 
Bracketing Date 

Confidential

Monies due/ 
past due 

Treatment Information 

Type of malocclusion, and 
often other diagnoses 

Employer 
information 

Confidential

Confidential

This form may include treatment information as well as payment information and other 
confidential information. See Section XI: Removal of Confidential Information. 
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Figure 10.5: Sample Patient Identification Card 
 

 

Confidential

 

Monies paid 

Treatment Information 

Type of malocclusion, 
and often other diagnoses 

______________________________________________________________________________ 
The Patient Card often has diagnostic information on the back. If the diagnosis matches that on 
the “Case Analysis” or on another form, do not enter the same diagnosis multiple times. 
However, the diagnosis does not match, enter the diagnosis using the date on the front of the card 
as the Treatment Date. 
If there is insurance information or monies information, copy the card, then black out on the card 
and place the copy into the confidential file. 
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Figure 10.6: Sample Transfer Form 
 

 
 

Confidential 

Treatment 
Information 

Monies due/ 
past due 

______________________________________________________________________________ 
This form does include treatment information and can also include payment information and 
other confidential information. See Section XI: Removal of Confidential Information. 
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Figure 10.7: Sample Treatment Record 
 
 

 

Treatment 
Information 

 
______________________________________________________________________________ 

Monies due/ 
past due 

Confidential

This form does include treatment information and can also include payment information and 
other confidential information. See Section XI: Removal of Confidential Information.  
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Figure 10.8: Sample Cephalometrics Form 
 
  

 
 
 
 
 
 
 
 
 

These two pages are 
typical of cephalometrics 
taken by Dr. 
Economides. However, 
they are by no means the 
only source of 
measurements and are 
provided solely as an 
example.  

 
See Appendix F: 

Cephalometrics for 
matching of names as 
listed on this form to the 
abbreviations used in the 
database. 
 

 

Patient’s measurements

Enter the measurements 
in this column. Other 
columns do not reflect 
the patient, rather they 
refer to the descriptive 
statistics for the 
measurements. 
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Figure 10.9: Sample Cephalometrics Measurements Screen 
 
 

 
______________________________________________________________________________ 
Data entry screen as seen in database when Cephalometric button is clicked.  
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XI. Removal of Confidential Information 
A. Pulling confidential paperwork 

1. Purpose of pulling confidential paperwork 
a. To comply with HIPAA, and to protect patient confidentiality 
b. Examples of confidential information: 

i. Insurance information  
- Including Medicaid/ Medicare information 

ii. Monies past due 
iii. Patient/ parent(s) social security number 

- It is not necessary to pull forms simply because they contain a patient’s 
social security number.  

- If a form that is already being pulled also contains the SS#, it can be 
blacked out.  

- This is particularly relevant for the patient identification cards. Do not 
black out the SS# on the cards.  

iv. Patient/ parent(s) employer information 
Note:   Examples (i.) and (ii.) are the most important.  

2. What gets pulled? (includes, but not limited to) 
a. Forms/ pages with insurance information 

i. See Figure 11.1: Sample Orthodontic Insurance Form 
ii. See Figure 11.2: Sample Medicaid Utilization Review Forms 

b. Forms/ pages with monies due/ past due 
i. See Figure 11.3: Sample Bill 
ii. See Figure 11.4: Sample Transfer Form 
iii. See Figure 11.5: Sample Treatment Payment Plan 
iv. See Figure 11.6: Sample Treatment Record 
v. See Figure 11.7: Sample Treatment Contract Agreement 

c. Returned letter from Dr. Economides, such as bills 
d. Letters from patient (or guardian) discussing payment, but not treatment 
e. 30 Day Letters 

i. See Figure 11.8: Sample 30 Day Letter 
f. Forms/ pages relating to bankruptcy 

i. See Figure 11.9: Sample Bankruptcy Form 
ii. See Figure 11.10: Sample Bankruptcy Letter 

3. Other possible locations of confidential information 
a. Patient information card 
b. Exterior of the patient’s folder 

i. Examples: 
- “Pd” 
- “08080” or “08090” etc 
- Insurance company information 

 
B. Deidentifying confidential paperwork 

2. Papers with confidential information will placed in the patient’s confidential file 
a. Archival Quality file folder 
b. Confidential file needs to be labeled with the patient’s accession number 
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c. Label file folder with a “Sharpie® Permanent Marker Ultra Fine Point” 
3. Pages without treatment information 

a. Examples:  
i. See Figure 11.5: Sample Treatment Payment Plan 
ii. See Figure 11.7: Sample Treatment Contract Agreement 
iii. See Figure 11.8: Sample 30 Day Letter 
iv. See Figure 11.9: Sample Bankruptcy Form 
v. See Figure 11.10: Sample Bankruptcy Letter 

b. To deidentify: 
i. These forms/ letters get pulled 
ii. Place in the patient’s confidential file 

4. Pages that also contain treatment information 
a. Examples:  

i. See Figure 11.1: Sample Orthodontic Insurance Form 
ii. See Figure 11.2: Sample Medicaid Utilization Review Form 
iii. See Figure 11.3: Sample Bill 
iv. See Figure 11.4: Sample Transfer Form 
v. See Figure 11.6: Sample Treatment Record 

b. To deidentify: 
i. These forms/ letters get pulled 
ii. Cover confidential information with a post-it® note or piece of paper 

- Cut or tear post-it® or paper as needed to obtain reasonable sized pieces 
- Yellow post-it® work best as they do not show on the photocopy 

iii. Photocopy form/ letters with post-it® or paper in place 
- Make sure not to cover important information such as the patient number 

iv. Photocopy gets placed in the patient’s folder 
v. Original gets placed in the patient’s confidential folder 

5. Other locations (patient identification card and folder) 
a. Photocopy card/ folder 
b. The photocopy goes in the patient’s confidential file 
c. The confidential information on the card/ folder gets black out 

i. Use a “Sharpie® Permanent Marker Fine Point” to black out confidential 
information 

ii. If confidential information can still be read through the blacking out, then 
scribble over with a pen 

iii. On patient information card – be careful of the marker bleeding though 
card 

d. Replace card in the patient’s folder 
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Figure 11.1: Sample Orthodontic Insurance Form 
 

______________________________________________________________________________ 

Accession number

Make sure the 
accession number 
remains visible 

Insurance information 

Insurance/ employee 
information 

Employee information 

This form may include treatment information as well as confidential information. Cover the 
confidential information with a post-it® for photocopying.  

Treatment 
Information 

Monies 
Due/  
past due 

Monies Due/ past due

Treatment 
Information

Image includes post-it® 
over confidential 
information for an example 
of placement. 
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Figure 11.2: Sample Medicaid Utilization Review Forms 
 

 

 

Accession number 
 

Make sure the 
accession number 
remains visible 
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______________________________________________________________________________ 
This form does include treatment information. However, it also does include insurance 
information (Medicaid). Cover the confidential information with a post-it® for photocopying. 

Treatment 
Information 

Insurance information 
- Medicaid 

Insurance information 
- Medicaid 

Insurance 
form number Insurance 

information 
- MedicaidImages includes post-it® 

over confidential 
information for an example 
of placement. 



Figure 11.3: Sample Bill 
 

 
 

Confidential 

Because this is a large 
area, and the confidential 
information will vary in 
size, cover this area with 
either a blank piece of 
paper or a post-it®. 

Treatment Information

______________________________________________________________________________ 
This form may include treatment information as well as confidential information. Cover the 
confidential information with a post-it® or piece of paper for photocopying. 
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Figure 11.4: Sample Transfer Form 
 

 
 

Image includes post-it® 
over confidential 
information for an example 
of placement. 

Monies due/ 
past due 

Treatment 
Information 

______________________________________________________________________________ 
This form does include treatment information and can also include payment information. Cover 
the confidential information with a post-it® for photocopying.
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Figure 11.5: Sample Treatment Payment Plan 
 

 
 
______________________________________________________________________________ 
This letter usually does not include any information that is relevant to the patient’s treatment. 
Therefore, this letter can get pulled and placed into the confidential file. It does not need to be 
photo copied. 
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Figure 11.6: Sample Treatment Record 
 
 

 

Treatment 
Information 

 
 

______________________________________________________________________________ 

Because this is a large area, and the 
confidential information will vary in 
size, cover this area with either a 
blank piece of paper or a post-it®. 

Confidential

Treatment information 

This form does include treatment information and can also include payment information. Cover 
the confidential information with a post-it® or piece of paper for photocopying.  
 
Read through the treatment information section for references to 30 day letters, monies paid or 
due, and other confidential information. Cover or black out all confidential information. 
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Figure 11.7: Sample Contract Agreement 
 

 
 
______________________________________________________________________________ 
This form does not include any information that is relevant to the patient’s treatment. Therefore, 
this form can get pulled and placed into the confidential file. It does not need to be photocopied. 
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Figure 11.8: Sample 30 Day Letter 
 

 
 
______________________________________________________________________________ 
This form does not include any information that is relevant to the patient’s treatment. Therefore, 
this form can get pulled and placed into the confidential file. It does not need to be photocopied. 
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Figure 11.9: Sample Bankruptcy Form 
 

 
 
______________________________________________________________________________ 
This form does not include any information that is relevant to the patient’s treatment. Therefore, 
this form can get pulled and placed into the confidential folder. It does not need to be 
photocopied. 
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Figure 11.10: Sample Bankruptcy Letter 
 

 
 
______________________________________________________________________________ 
This letter does not include any information that is relevant to the patient’s treatment. Therefore, 
this letter can get pulled and placed into the confidential folder. It does not need to be 
photocopied. 
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XII. Five Percent Check 
A. For every 100 patients entered, 5% of them need to be checked 

1. Randomly pull 5 patients from each 100 patients entered 
2. Check all data entered 

a. Name 
b. Date of birth 
c. Sex 
d. Phone number / address 
e. Ancestry estimates – for each estimation 

i. EstimateDate 
ii. Reporter 
iii. Patient’s Ancestry Estimation 

- Traits upon which estimation estimate was based  
- Minimum of 2 reporter’s ancestry estimation 

f. Other characteristics (thumb sucking, mouth breathing, etc.) 
g. Treatment Events 

i.  Tooth extraction 
ii.  Banding/ Bracketing 
iii.  Surgical Exposure 
iv.  De-banding 
v.  Orthognathic Surgery 
vi.  Retention 
vii.  Orthodontic Diagnosis 
viii. Congenitally Missing Teeth 
ix.  POG 
x.  Inter-oral photos 
xi.  X-Rays 

h. Cephalometrics 
 

B. Record errors found: 
1. In file “5% check” 
2. File location: “N:\” 
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Appendix A: Directory  
 
 
Not available.  
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Appendix B: Image Naming Convention 
 
ImageType_Year_Accession#_Object#_TreatmentDate_ViewCode_Ordinal 
          1           2 3        4        5  6       7 
Where: 
1 – ImageType   =   P (Photo) or X (R-Ray) 
 
2 – Year   =   2005 
 
3 – Accession#   =   19 
 
4 – Object#   =   1 through x, the unique number assigned to this patient 
 
5 – TreatmentDate   =   YYYYMMDD the image was taken 

For images where the entire date is not legible, type “X” where numbers are unknown.  
For example: if the month cannot be read but the year and day can be read, the 

TreatmentDate is “YYYYXXDD” 
 
6 – ViewCode describes the view in the image 

P (Photo) – can also be used for x-rays if needed
antb 
llb 
mxo 
mdo 
rlb 

X (X-Ray) 
AP 
hd 
lat 
pan 
TMJ 
waters 
unknown 

Anterior bite [closed teeth] 
Left lateral bite [closed teeth] 
Maxillary occlusal 
Mandibular occlusal 
Right lateral bite [teeth closed] 
 
Anterior-posterior 
Hand (has also been saved as “hr,” “hl,” and “hand”) 
Lateral 
Panaview 
TMJ view (can also be saved as “LTMJ” or “RTMJ,” left or right side) 
Waters View 
View unknown, or of a type not listed above. Also is used for the “no xray” 
image for cephalometrics without x-rays 

 
7 – Ordinal   =   1, 2, etc. with default of 1 (to account for multiple images of the same view on 

the same date - these should be physically marked for future matching) 
 
Examples:   
 Photo of anterior view of teeth in occlusion taken on February 3, 1999 of patient 2005.19.70 
  P_2005_19_70_19990203_antb_1 
 Panaview x-ray of the same patient taken January 16, 2002 
  X_2005_19_70_20020116_pan_1 
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Appendix C: Tooth Naming Convention 
 

Deciduous Dentition 
Side      Right            Left 
Tooth Type     m m c i i | i i c m m 
Tooth Letter     e d c b a | a b c d e  
Database     A B C D E | F G H I J  
   ---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

Database     T S R Q P | O N M L K 
Tooth Letter     e d c b a | a b c d e 
Tooth Type     m m c i i | i i c m m 

 
Permanent Dentition 

Side   Right                  Left 
Tooth Type  M M M P P C I I | I I C P P M M M 
Tooth #   8 7 6 5 4 3 2 1 | 1 2 3 4 5 6 7 8 
Database  1 2 3 4 5 6 7 8 | 9 10 11 12 13 14 15 16 
   ---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------- 

Database  32 31 30 29 28 27 26 25 | 24 23 22 21 20 19 18 17 
Tooth#   8 7 6 5 4 3 2 1 | 1 2 3 4 5 6 7 8 
Tooth Type  M M M P P C I I | I I C P P M M M 
 
Deciduous Dentition 
A Deciduous Right Maxillary Second Molar 
B Deciduous Right Maxillary First Molar 
C Deciduous Right Maxillary Canine 
D Deciduous Right Maxillary Lateral Incisor 
E Deciduous Right Maxillary Central Incisor 
F Deciduous Left Maxillary Central Incisor 
G Deciduous Left Maxillary Lateral Incisor 
H Deciduous Left Maxillary Canine 
I Deciduous Left Maxillary First Molar 
J Deciduous Left Maxillary Second Molar 
K Deciduous Left Mandibular Second Molar 
L Deciduous Left Mandibular First Molar 
M Deciduous Left Mandibular Canine 
N Deciduous Left Mandibular Lateral Incisor 
O Deciduous Left Mandibular Central Incisor 
P Deciduous Right Mandibular Central Incisor 
Q Deciduous Right Mandibular Lateral Incisor 
R Deciduous Right Mandibular Canine 
S Deciduous Right Mandibular First Molar 
T Deciduous Right Mandibular Second Molar 
 

 
 
 
 
 
 
 
 
 
 
 

Permanent Dentition 
#1 Permanent Right Maxillary Third Molar 
#2 Permanent Right Maxillary Second Molar 
#3 Permanent Right Maxillary First Molar 
#4 Permanent Right Maxillary Second Premolar 
#5 Permanent Right Maxillary First Premolar 
#6 Permanent Right Maxillary Canine 
#7 Permanent Right Maxillary Lateral Incisor 
#8 Permanent Right Maxillary Central Incisor 
#9 Permanent Left Maxillary Central Incisor 
#10 Permanent Left Maxillary Lateral Incisor 
#11 Permanent Left Maxillary Canine 
#12 Permanent Left Maxillary First Premolar 
#13 Permanent Left Maxillary Second Premolar 
#14 Permanent Left Maxillary First Molar 
#15 Permanent Left Maxillary Second Molar 
#16 Permanent Left Maxillary Third Molar 
#17 Permanent Left Mandibular Third Molar 
#18 Permanent Left Mandibular Second Molar 
#19 Permanent Left Mandibular First Molar 
#20 Permanent Left Mandibular Second Premolar 
#21 Permanent Left Mandibular First Premolar 
#22 Permanent Left Mandibular Canine 
#23 Permanent Left Mandibular Lateral Incisor 
#24 Permanent Left Mandibular Central Incisor 
#25 Permanent Right Mandibular Central Incisor 
#26 Permanent Right Mandibular Lateral Incisor 
#27 Permanent Right Mandibular Canine 
#28 Permanent Right Mandibular First Premolar 
#29 Permanent Right Mandibular Second Premolar 
#30 Permanent Right Mandibular First Molar 
#31 Permanent Right Mandibular Second Molar 
#32 Permanent Right Mandibular Third Molar 





Appendix D: Cephalometrics 
 
Local Index Number: 

 Text Description 
of Measurement: 

Economides 
Abbreviations 

Type of 
Measurement Description 

 
Denture to Skeleton 

 Apo to Lower 
Incisor 

APO _PT II length Distance from the incisal edge of 
the mandibular central incisor 
perpendicular to the A-Pogonion 
line 
 

 Inter Incisal 
Angle 

INC/ANGLE degrees The intercisal angle, which is the 
anterior angle formed at the 
intersection of the long axes of the 
maxillary and mandibular central 
incisors.  
 

 IMPA Angle to 
Lower Inc to Go 
GN 

IMPA degrees The  posterior-superior angle 
between the long axis of the 
mandibular central incisor and the 
mandibular plane (Gonion to 
Gnathion) 
 

 Upper One to S-N ILS/NSL degrees The posterior-inferior angle 
formed by the long axis of the 
maxillary central incisor and the 
Sella-Nasion line 
 

 Lower Incisor to 
Nasion-B Point 

ILI/N-SM degrees The inferior angle formed by the 
long axis of the mandibular 
central incisor and the Nasion-B 
point line 
 

 Molar 
Relationship 

MOLAR REL length The distance from between the 
distal crown convexities of the 
upper and lower permanent first 
molars, measured along the 
occlusal plane 
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Local Index Number: 

 Text Description 
of Measurement: 

Economides 
Abbreviations 

Type of 
Measurement Description 

 
Denture to Skeleton - Continued 

 Measured Line 
NB to II 

NB_LINE II length The distance from the incisal edge 
of the mandibular central incisor 
to the Nasion-B point line 
 

 Overbite OVERBITE length The distance between the incisal 
edges of the upper and lower 
central incisors measured 
perpendicular to the occlusal 
plane 
 

 Overjet OVERJET length The distance between the incisal 
edges of the upper and lower 
central incisors measured along 
the occlusal plane 
 

 Distal U6 to PTV 
at Occlusal Plane 

DU6_PTV length The distance from the distal crown 
contact of the maxillary first 
molar measured back to 
Pterygoid-Vertical (line from 
Pterygoid, perpendicular to the 
Frankfort horizontal) 
 

 Upper One to Lip 
Embrassure 

IS-LIP EMB length The vertical distance from the tip 
of the maxillary central incisor to 
Lip Embrassure (the contact point 
between upper and lower lips) , 
measured perpendicular to the 
palatal plane 
 

 
Skeletal Relationships 

 Condylion to GN CO-GN length The straight line distance between 
Condylion and Gnathion 
 

 Condylion to 
Gonion 

CO-GO length The distance between Condylion 
and Gonion 
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Local Index Number: 

 Text Description 
of Measurement: 

Economides 
Abbreviations 

Type of 
Measurement Description 

 
Skeletal Relationships – Continued  

 Max. Length CO-SS length The distance between Condylion 
and A point 
 

 Facial Taper GO-GN-SS degrees The superior-posterior angle 
formed by the Nasion-Pogonion 
line and the mandibular line 
(Gonion to Menton) 
 

 Facial Angle N-PG/FH degrees The posterior-inferior angle at the 
intersection of the Nasion-
Pogonion line and the Frankfort 
Horizontal plane 
 

 Angle of 
Convexity 

N-SS-PG degrees The superior angle between the 
line Nasion-Subspinale (A point) 
and the line A point-Pogonion 
 

 Sella Nasion to 
Mandibular Line 

NSL-ML degrees The anterior angle formed by the 
Sella-Nasion line and the 
Mandibular line (Gonion-Menton) 
 

 Angles 
Describing 
Inclination 

NL-ML degrees The angle formed by the Nasion-
Subspinale (A point) line and the 
mandibular line (Gonion-
Gnathion) 
 

 
Lip Relationships 

 Holdaway Angle NS-LCT-LS degrees The inferior-posterior angle 
between the H line (The most 
anterior superior point of the soft 
tissue chin and Labrale superius) 
and the Frankfort Horizontal 
Plane 
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Local Index Number: 

 Text Description 
of Measurement: 

Economides 
Abbreviations 

Type of 
Measurement Description 

 
Lip Relationships – Continued  

 Soft Tissue Chin 
Thickness 

PG-PGS length The distance from hard tissue 
Pogonion to soft tissue Pogonion, 
measured parallel with Frankfort 
Horizontal plane.  
 

 Lip, Upper 
Thickness (MM) 

PLS-LS length The distance from Labrale 
Superius back to the maxillary 
central incisor measured parallel 
with Frankfort Horizontal Plane.  
 

 sub nasal to upper 
lip 

SN-UL length Upper lip length from subnasale to 
Upper Lip Stomion 
 

 Sub Nasal Sulcus SN-SNP length Distance from the H-Line(line 
extending from Soft Tissue 
Pogonion to Labrale Superius) to 
the Superior Labial Sulcus 
 

 Lip Thickness 
Upper/Upper 

SS-PSSS length Distance from hard tissue A point 
to soft tissue A point 
 

 
Y Axis Group 

 Facial Axis BA-CC-GN degrees The inferior angle between the 
Basion-Nasion line and CC 
(Pterygoid-Gnathion line) 
 

 Y Axis to 
Frankfort 
Horizontal 

FH/S-GN degrees The anterior-inferior angle 
between the Frankfort Horizontal 
line and the Sella-Gnathion line 
 

 Y Axis to Se-Na N-S-GN degrees The anterior-inferior angle formed 
by the intersection of the Sella-
Nasion line and the Sella-
Gnathion line 
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Local Index Number: 

 Text Description 
of Measurement: 

Economides 
Abbreviations 

Type of 
Measurement Description 

 
Deep Internal Structures 

 FMA Angle FMA degrees The anterior-inferior angle formed 
by the Frankfort Horizontal line 
and the Mandibular line (Gonion-
Menton) 
 

 Angles 
Describing SNPG 
(Sella/Nasion/Pog
onion)/ 
Mandibular 
relationship 
 

S-N-PG degrees The inferior-posterior angle 
formed by the Sella-Nasion line 
and the Nasion-Pogonion line 

 Angles 
Describing SNB 
(Sella/Nasion/Sup
ramentale) 
 

S-N-SM degrees The inferior-interior angle defined 
by Sella, Nasion and 
Supramentale (B point) 

 Angles 
Describing SNA 
(Sella/Nasion/SS) 

S-N-SS degrees The posterior-inferior angle 
formed by Sella, Nasion, and 
Subspinale (A point) 
 

 Angles 
Describing 
Antero-Post/ANB 

SS-N-SM degrees Angle defined by Subspinale (A 
point), Nasion, and Supramentale 
(B point) 
 

 
Airway Widths 

 Adenoid Space ADENOIDS length Distance from one adenoid to the 
other 
 

 Tonsilar Width TONSIL length Distance of the tonsil from 
anterior to posterior 
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 Text Description 
of Measurement: 

Economides 
Abbreviations 

Type of 
Measurement Description 

 
Special Measurements 

 Mandibular Arc CO-XI-DC degrees The anterior-superior angle 
formed by Condylion to Xi 
(geographic center of the ramus) 
to DC (the midpoint of the outline 
of the condylar process where it is 
crossed by the inferior border of 
the cranial base) 
 

 Lower Facial Hgt. 
Angle 

SPA-XI-PM degrees The anterior angle formed by 
Spinale Anterior (ANS) to Xi 
(geographic center of the ramus) 
to Suprapogonion (Pm- point 
along curvature of symphysis 
which changes form convexity to 
concavity) 
 

 Wits Analysis AO-BO length Distance between A point and B 
point, each projected to the 
Functional Occlusal Plane (line 
passing through posterior cusp of 
the maxillary first molar  and a 
line along the occlusion of the 
maxillary and mandibular 
premolars and a line perpendicular 
to it through the averaged anterior 
contact of the first maxillary 
premolars with the maxillary 
canine(cuspid) 
 

 
Facial Ratios 

 Face Low/Face 
All/Percent 

Face Low/Face 
All/Percent 

percentage The ratio of the distance from 
Subnasale to soft tissue Menton to 
the distance from the hairline to 
soft tissue Menton multiplied by 
100 
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 Text Description 
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Economides 
Abbreviations 

Type of 
Measurement Description 

 
Facial Ratios – Continued  

 Face L/L Face 
Low/Percent 

Face L/L Face 
Low/Percent 

percentage The ratio of the distance from the 
embrassure of the lower central 
incisor to the Chin Tangent to the 
distance from Subnasale to soft 
tissue Menton multiplied by 100 
 

 Face Mid/Face 
Low/Percent 

Face Mid/Face 
Low/Percent 

percentage The ratio of the distance from soft 
tissue Glabella to Subnasale to the 
distance from Subnasale to soft 
tissue Menton multiplied by 100 
 

 Face L/L Face 
All/Percent 

Face L/L Face 
All/Percent 

percentage The ratio of the distance from the 
embrassure of the lower central 
incisor to the Chin Tangent to the 
distance from the hairline to soft 
tissue Menton multiplied by 100 
 

 Face Mid/Face 
All/Percent 

Face Mid/Face 
All/Percent 

percentage The ratio of the distance from soft 
tissue Glabella to Subnasale to the 
distance from the hairline to soft 
tissue Menton multiplied by 100 
 

 Face L/L Face 
Mid/Percent 

Face L/L Face 
Mid/Percent 

percentage The ratio of the distance from the 
embrassure of the lower central 
incisor to the Chin Tangent to the 
distance from soft tissue Glabella 
to Subnasale  multiplied by 100 
 

 Face Upper/Face 
All/Percent 

Face 
Upper/Face 
All/Percent 

percentage The ratio of the distance from the 
hairline to soft tissue Glabella to 
the distance from the hairline to 
soft tissue Menton multiplied by 
100 
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 Text Description 
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Economides 
Abbreviations 

Type of 
Measurement Description 

 
Facial lengths 

 Face All Face All length The distance from the hairline to 
Menton (soft tissue) 
 

 Face Lower 
Incisor to Chin 

Face Lower 
Incisor to Chin 

length The distance from the embrassure 
of the lower central incisor to the 
Chin Tangent 
 

 Face Low Face Low length The distance from soft tissue 
Subnasale to soft tissue Menton 
 

 Face Mid Face Mid length The distance from soft tissue 
Glabella to Subnasale 
 

 Face Up Face Up length The distance from the hairline to 
soft tissue Glabella 
 

 Glabella to 
Subnasale 

GA-SN length Distance from Soft tissue Glabella 
to Subnasale (Parallel to Frankfort 
Horizontal Plane) 
 

 Lower Chin 
Tangent/Lower 
Lip 

LI-LCT length Distance from Labrale Inferius to 
Lower chin tangent (The most 
anterior superior point of the soft 
tissue chin) (Parallel to the 
Frankfort Horizontal Plane) 
 

 Lip Embrassure to 
Menton 

LIP_EMB-ME length Distance from the Stomion 
inferius to the Soft Tissue 
Pogonion (Parallel to the 
Frankfort Horizontal Plane) 
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 Text Description 
of Measurement: 

Economides 
Abbreviations 

Type of 
Measurement Description 

 
Facial lengths – Continued  

 Upper Lip to Chin 
Tangent 

LS_LCT length Distance from Labrale superius to 
Lower chin tangent (The most 
anterior superior point of the soft 
tissue chin) (Parallel to the 
Frankfort Horizontal Plane) 
 

 Anterior Facial 
Height 

AFH length Distance between Nasion and  
Menton 
 

 Subnasale to 
Lower Lip 

SN-LI length Distance from the Labius inferius 
to Subnasale projected onto the 
Frankfort Horizontal Plane 
 

 Subnasale/Lip 
Embrassure 

SN-LIP E length Distance from the Labius superius 
to Subnasale projected onto the 
Frankfort Horizontal Plane 
 

 SPA-PG SPA-PG length Distance from the Spinus Anterior 
to pogonion 
 

 
Other 

 Subnasale/Lower 
Lip 

SN-LI length Distance from the Labius inferius 
to Subnasale projected onto the 
Frankfort Horizontal Plane 
 

 Posterior Facial 
Height 

PFHGT length Distance from the CF point 
(where the Frankfort Horizontal 
line crosses the Pterygoid vertical 
line) to Gonion 
 

 Incisor 
mandibular plane 
angle  

ILI/ML degrees The posterior- superior angle 
between the long axis of the 
mandibular central incisor and the 
mandibular plane 
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 Text Description 
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Economides 
Abbreviations 

Type of 
Measurement Description 

 
Other – Continued  

 Naso-Labial 
Angle 

LNT-SN-LS angle The anterior angle between the 
base of the nose and the Subnasale 
to Labrale superius line 
 

 McNamara 
90/Nasion 

MC90-N length The distance from the McNamara 
90 point to Nasion 
 

 Upper 
Incisor/Nasion-A 
Point 

ILS/N-SS degrees The superior angle formed by the 
long axis of the maxillary central 
incisor and the Nasion-Subspinale 
(A point) line 
 

 Upper One to 
Nasal Line 

ILS/NL degrees The superior angle formed 
between the long axis of the 
maxillary central incisor and the 
Nasal line (Anterior Nasal Spine 
to Posterior Nasal Spine) 
 

 CO-SPA CO-SPA length The straight line distance between 
Condylion and Spinale Anterior 
(A point) 
 

 Frankfort 
Horizontal 

FH (Po-Or) length The linear distance between 
Porion and Orbitale  
 

 Mandibular Line ML length The distance between Gonion and 
Gnathion 
 

 Occlusal Plane OCC-PL length The distance between the 
midpoint of the line connecting 
the lower and upper incisal edge 
and the midpoint of the line 
connecting the anterior cusp tip of 
the maxillary and mandibular first 
molar 
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Economides 
Abbreviations 

Type of 
Measurement Description 

 
Other – Continued  

 Line McNamara 
to IS 

IS-MCIS length The distance of the incisal edge of 
the maxillary central incisor 
relative to the A  line (Line 
through A point and perpendicular 
to the Frankfort horizontal plane) 
 

 Posterior Face 
Height 
 

PFH length Distance from Sella to Gonion 

 Ramus Height RH length Distance from Articulare to 
Gonion 
 

 Spa to Vert Line SPA-ME length Distance from menton projected 
perpendicular to the palatal plane 
(Anterior to Posterior nasal spine) 
 

 Gonial Angle AR-GO-ME degrees The angle formed by Articulare, 
Gonion and Menton 
 

 Nose Chin Line/ 
Nose Chin length 

LNT-LCT length Lower Nasal Tangent( to the 
Lower Chin Tangent (The most 
anterior superior point of the soft 
tissue chin) 
 

 S-N to Palatal 
Plane 

NSL-NL degrees The angle between the Sella-
Nasion line and the Palatal plane 
(ANS-PNS) 
 

 
Extras- Not on Cephalometric sheet in database 

 Subnasale to Chin 
Tangent 

SN-PGS length The distance from Subnasale to 
the Chin Tangent (the most 
anterior superior point of the soft 
tissue chin) 
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Extras- Not on Cephalometric sheet in database – Continued  

 Palatal plane - 
Mandibular plane 

PP-ML degrees The posterior angle formed by the 
palatal plane (Anterior nasal spine 
and Posterior nasal spine) and the 
mandibular plane (Gonion to 
Menton) 
 

 Lower 
Lip/menton 

LI-ME length Distance from Labrale Inferius to 
Soft tissue Menton 
 

 Line SS to 
McNamara 90 

SS-MCSS length The distance between A point and 
McNamara 90 
 

 Subnasale/Mento
n 

SN-ME length The distance from Subnasale to 
Soft tissue Menton 
 

 Posterior Cranial 
Base Length 
 

PCL length Distance from Sella to Articulare 

 Cranial Length 
Anterior 

CC/N length The distance from the CC point 
(the point where the basion-nasion 
plane and the facial axis intersect) 
to Nasion  
 

 Lower Incisal 
Axis 

II-AI length The distance on the Lower central 
incisor from the incision inferius 
to the apex 
 

 Upper Incisal 
Axis 

IS-AS length The distance on the Upper central 
incisor from the Incision superius 
to the apex superior 
 

 Mandibular Body 
Length 

MBL length The distance between Gonion and 
Menton 
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Extras- Not on Cephalometric sheet in database – Continued  

 Nasal Line NL length The distance between the Anterior 
and Posterior Nasal Spine 
 

 Nasion Sella Line NSL length The distance between Sella and 
Nasion 
 

 Palatal Plane 
Angle 

NSL-PP degrees The angle between the Sella-
Nasion line and the Palatal plane 
(ANS-PNS) 
 

 
 





Glossary: 
 
accession number Identifying number assigned to each patient as they are accessioned 

into the Maxwell collection. 
Contains three parts. The first two (2005.19.) are shared by all 

patients included within the Economides' collection, while the 
third is unique to each patient. 

 
 

cast Dental casts belonging to a specific patient 
 
 

confidential file Archival quality file folder labeled with the patient's accession 
number. These files are stored in a separate box than the box with 
the patient folders.  

 
 

e-folder Electronic folder located on the N: drive that contains all images for a 
given patient. (N:\Images\Orthodontics) 

These e-folders are organized within e-folders of 50 patients which 
are within e-folders of 500 patients 

 
 

folder The physical patient folder donated by Dr. Economides 
 
 

HIPPAA Health Insurance Portability and Accountability Act 
Law to pretect patient confidentiality 
 

Hospital Security Office located on the first floor of UNMH 
Phone number: 272-2160 
 
 

HSC ID badge ID badge issued by the HSC 
This badge is required for entry into the Radiology Department 
 
 

HSC username and 
password 

Username for the Health Science Center network 
Password – your password for this username 
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Learning Central Website for Health Science Center online training 
https://learningcentral.health.unm.edu/plateau/user/login.jsp 
 
 

object number Unique number for each patient. Last of the three parts of the 
accession number 

 

Osteology Lab Maxwell Museum Laboratory of Human Osteology 
Anthropology building, room #165 
Phone number: 277-3535 
 

PACS username and 
password 

Username and Password will be provided upon request 
Used only for logging onto the computers in the Radiology 

Department at the UNM Hospital 
 
 

patient identifier Any information that identifies the patient as an individual.  
Includes name, date of birth, and patient number 
 
 

patient number Identifying number assigned to each patient by Dr. Economides.  
In general this number begins with the last one or two digits of the 

year when the patient joined his practice 
 
 

Radiology Department Located on the first floor of UNMH 
Phone number: 272-2269 
 

reporter Employee on the Orthodontic Project who enters data.  
Specifically to identify which employee made the ancestry estimation 

for a patient 
 
 

UNM Net ID and 
password 

UNM Net ID - username@unm.edu 
Password – your password for your UNM accounts 
 
 

 
 

https://learningcentral.health.unm.edu/plateau/user/login.jsp
mailto:username@unm.edu
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